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Programmbeschreibung

Dieser Editor ermöglicht es Anwenderseiten für das EIB LCD Touch Modul zu 
erstellen.
Das EIB LCD Touch Modul stellt eine flexible, multifunktionale 
Bedienoberfläche für EIB Installationen dar. Hierzu zeigt es grafisch frei 
gestaltbare Seiten aus statischen und dynamischen Elementen an. Die 
dynamischen Elemente sind mit EIB Objekten verknüpft. Sie können aktuelle 
Zustände anzeigen bzw. Steuerfunktionen ausüben.

Die Gestaltung der Bedienoberfläche erfolgt mit Hilfe dieses Editors. Die 
erzeugten Daten müssen durch eine SD Karte auf das LCD Touch Modul 
übertragen werden.

Sämtliche grafischen Elemente basieren auf Vorlagen einer Grafikbibliothek. 
Diese Vorlagen können mit Hilfe eines beliebigen Grafikprogramms erstellt 
werden. Dieser Editor besitzt lediglich eine Importfunktion für Vorlagen.
Einzelne Seitenelemente besitzen die Fähigkeit, elementspezifischen Text in 
die Vorlagen einzublenden. Das reduziert die Anzahl benötigter Vorlagen 
drastisch, bedeutet aber zugleich weniger gestalterischen Freiraum bei den 
Endergebnissen.



Das Hauptfenster

Nach dem Start des LCD Modul Editor Programms öffnen sich das 
Hauptfenster sowie Zusatzfenster zum bearbeiten der Anwenderseiten.
Die folgende Abbildung zeigt das Hauptfenster mit geöffnetem Projekt.

Programmfunktionen lassen sich alternativ über die Menüleiste oder eine 
Buttonleiste aufrufen.
Der Arbeitsbereich stellt die über Reiter auswählbaren Benutzerseiten dar. 
Elemente auf der momentan aktiven Seite können bearbeitet werden.

Ein bestehendes Projekt Laden
Ein bestehendes Projekt wird über den Menüpunkt „File → Load“ oder den 
File Open Button geladen:



Es öffnet sich ein Dialog zur Auswahl der Projektdatei. Die Projektdateien 
tragen die Endung „.lcd“.
Hinweis:
LCD Projektdateien können nicht direkt in das LCD Touch Modul geladen 
werden. Sie müssen hierzu erst in ein spezielles Format überführt werden. 
Siehe Ein Projekt exportieren.

Physikalische Geräteadresse
Die physikalische Geräteadresse wird in den Projektoptionen definiert. Der 
Dialog öffnet sich über den Menüeinträge „Project → Options“. Die 
physikalische Adresse wird mit in die Datei geschrieben, die in das LCD 
Modul übertragen wird.

Ein Projekt exportieren
Das Projekt muss in eine Datei mit speziellem Format geschrieben werden, 
um die Projektdaten in das LCD Modul zu übertragen. Hierzu dient der 
Menübefehl „Project → Export“ oder folgender  Button:

Die Dateiendung muss auf „.lcdb“ lauten. Ansonsten wird die erzeugte Datei 
vom LCD Touch Modul ignoriert. Der Dateiname kann ansonsten frei 
bestimmt werden. Das Ende des Exportierens wird durch einen Dialog 
angezeigt.
Am günstigsten wird die Datei in einem lokalen Verzeichnis erzeugt und 
anschließend auf die SD Karte kopiert, um sie in das LCD Touch Modul zu 
übertragen.



Der Elementdialog
Der Elementdialog stellt alle verfügbaren Elemente für die Anwenderseiten 
über Buttons zur Verfügung. Mit dem Anklicken eines Buttons erzeugt der 
Editor eine neue Instanz des entsprechenden Elements auf der momentan 
aktuellen Projektseite.

Als grafische Vorlage wird das momentan in der Grafikbibliothek ausgewählte 
Icon verwendet (siehe“Fehler: Referenz nicht gefunden„). Wenn das Element 
mehr als ein Icon benutzt, dann werden die in der Liste folgenden Icons 
hierzu benutzt. Daher ist es sinnvoll, die Liste entsprechend sortiert 
aufzubauen:

Icon1 off bzw. Icon1 up
Icon1 on bzw. Icon1 down
Icon2 off bzw. Icon2 up
….

Dies erleichtert das anlegen neuer Elemente. Die Zuweisung der Icons kann 
jederzeit über den Eigenschaften Dialog geändert werden.

Der Dialog wird über den Button      ein- oder ausgeblendet.

Die Elemente sind im Kapitel Bildelemente beschrieben.



Eigenschaften Dialog
Dieser Dialog zeigt sämtliche vom Benutzer bestimmbaren Eigenschaften 
des momentan ausgewählten Seitenelements an. Ein Seitenelement wird 
durch anklicken mit der Maus ausgewählt. Ausgewählte Seitenelemente 
besitzen einen gelben Rahmen.

Der Dialog wird über den Button       ein- oder ausgeblendet.



Ausrichtungsdialog
Dieser Dialog ermöglicht die schematische Ausrichtung von Bildelementen. 
Seine Funktionen wirken sich auf die aktuell ausgewählten Elemente aus.

Der Dialog wird über den Button       ein- oder ausgeblendet.

Die Schalterfunktionen sind:
1. linksbündig ausrichten
2. rechtsbündig ausrichten
3. Unterkanten bündig ausrichten
4. Oberkanten bündig ausrichten
5. gleichmäßig horizontal verteilen
6. gleichmäßig vertikal verteilen



Die Grafikbibliothek
Die Grafikbibliothek stellt die grafischen Vorlagen für die Anwenderelemente 
bereit. 

Grafische Vorlagen (Icons) sollten im BMP, GIF oder PNG Format vorliegen 
und passend skaliert sein. Die Grafikbibliothek zeigt Quelle und Format des in 
der Liste ausgewählten Icons an. Bilder im GIF und PNG Format können 
Transparenz enthalten, d.h. Sie können teilweise den Hintergrund 
durchscheinen lassen. Bilder im GIF Format sind jedoch auf 256 Farben 
limitiert. Daher empfiehlt sich das PNG Format zum Import von Icons.
Die Bilddaten werden durch den Import zum LCD Projekt hinzugefügt (Button 
„Add“). Neue Icons erscheinen immer am Ende der Liste.
Die Bibliothek speichert beim Import auch den Pfad der Quelldatei. Bei 
Bedarf, in der Regel wenn eine neue externe Version existiert, kann das Icon 
erneut aus dieser Quelldatei importiert werden (Button „Reload“).
Nicht mehr benötigte Icons lassen sich aus der Bibliothek entfernen (Button 
„Remove“).
Die Reihenfolge in der Icon Liste kann durch auswählen eines Icons und 
klicken der Buttons „Up“ oder „Down“ verändert werden. Eine sortierte Liste 
erleichtert die Neuanlage von Elementen auf den Anwenderseiten, siehe Der
Elementdialog



Bedienkonzept
Das LCD Touch Display stellt jeweils eine komplette Grafikseite von 320 x 
240 Pixeln dar. Die maximale Anzahl an Grafikseiten ist durch den fest im 
Gerät installierten Speicher begrenzt und beträgt ca. 30 Seiten abhängig von 
Art und Anzahl der gewählten Elemente.
Über die aktiven Touchelemente lassen sich Befehle an das Bussystem 
auslösen oder die Anzeige zu einer anderen Grafikseite wechseln. 
Bildelemente zur Anzeige aktueller Objektzustände stehen ebenfalls bereit.
Der hier beschriebene Editor ermöglicht das Anlegen und Bearbeiten der 
einzelnen Seiten und derer Bildelemente. 

Bildelemente
Das LCD Touch Display bietet folgende Bildelemente zum Aufbau einer Seite 
zur Auswahl:

• Text
Statischer Text, Schriftart, Schriftfarbe und Hintergrund wählbar

• Jumper
Schalter zum Sprung auf eine andere Seite

• Button
Schalter zum auslösen eines Bustelegramms

• S-Button
Schalter zum auslösen eines Bustelegramms mit binärer Statusanzeige

• LED
Binäre Statusanzeige, sendet optional ein/aus Telegramme

• Value
Anzeige Analoger Werte

• Picture
Statisches Hintergrundbild

Die Bildelemente „Jumper“, „Button“, „S-Button“, „LED“ und „Picture“ können 
über beliebige Icons aus der Grafikbibliothek dargestellt werden. Hierdurch 
bietet das Touch LCD Display eine hohe Flexibilität der grafischen Gestaltung 
dieser Elemente. Die Icons lassen sich mit einem beliebigen Grafikprogramm 
(z.B. Gimp) erzeugen.
Die Elemente „Text“ und „Value“ werden stets durch einen auswählbaren 
Zeichensatz dargestellt. Hintergrund und Textfarbe sind ebenfalls einstellbar.
Elemente „Jumper“, „Button“, „S-Button“ so wie „LED“ bieten noch eine 
gemischte Darstellungsvariante. Sie können ein Icon als Grundlagen 



verwenden und einen individuellen Text überlagern. Dies verringert die 
Vielzahl der benötigten Icons, wenn z.B. ein Icon zur Darstellung von 
Elementen mit jeweils eigener Beschriftung verwendet werden soll.
Hinweise:

• Bildelemente dürfen die Displayfläche nicht überragen.
• Icons für ein/aus bzw. gedrückt/nicht gedrückt eines Bildelements 

sollten die gleiche Größe aufweisen.

Allgemeine Parameter
Folgende Parameter haben soweit vorhanden bei allen Elementen die gleiche 
Funktion:

• width
Breite des Elements. Muss ausreichend groß gewählt werden, damit 
das Element und sein Inhalt vollständig dargestellt werden kann.

• height
Höhe des Elements. Muss ausreichend groß gewählt werden, damit 
das Element und sein Inhalt vollständig dargestellt werden kann.

• x-pos
horizontale Position des Elements auf der Seite. Startpunkt ist die linke, 
obere Ecke.

• y-pos
vertikale Position des Elements auf der Seite. Startpunkt ist die linke, 
obere Ecke.

• font
Texte oder Zahlen werden in diesem Zeichensatz angezeigt. Es stehen 
alle unter der  Java Umgebung verfügbaren Fonts zur Auswahl.

• text xpos
Horizontale Position des Textes innerhalb des Elements. Hierdurch 
lässt sich der Text innerhalb des Elements ausrichten. Fußpunkt ist die 
linke, untere Ecke des Textes.

• text ypos
Vertikale Position des Textes innerhalb des Elements. Hierdurch lässt 
sich der Text innerhalb des Elements ausrichten. Fußpunkt ist die linke, 
untere Ecke des Textes.

• text dx
Relative Verschiebung des Textes für Icon „down“ oder „on“ in 
horizontaler Richtung. Verstärkt den 3D Effekt.

• text dy



Relative Verschiebung des Textes für Icon „down“ oder „on“ in vertikaler 
Richtung. Verstärkt den 3D Effekt.

• opac
Bestimmt, ob das Element durchsichtig oder undurchsichtig ist. Wenn 
der Haken gesetzt ist, dann ist das Element undurchsichtig und die 
Hintergrundfarbe „background“ überdeckt den Seitenhintergrund. Wenn 
das Häkchen nicht gesetzt ist scheint der Seitenhintergrund durch und 
die Hintergrundfarbe des Elements wird ignoriert.

Text
Das Textelement stellt einen statischen Text auf einer Seite dar. Die Größe 
des Textfeldes, seine Farbe, die Ausrichtung des Textes und der Zeichensatz 
können frei bestimmt werden.
Das Text Element unterstützt folgende Parameter:

• label
Dieser Text wird vom Textelement angezeigt.

• color
Der Text wird in dieser Farbe angezeigt.

• background
Bestimmt die Hintergrundfarbe des Textelements. Nur aktiv, wenn der 
Parameter „opac“ gesetzt ist.



Jumper
Durch einen „Jumper“ wechselt die Anzeige auf eine andere Grafikseite. Das 
LCD Touch Display bietet zum Seitenwechsel praktisch keine fest installierte 
Funktion an. Alle Seiten müssen über „Jumper“ sinnvoll verkettet sein.
Eine Ausnahme besteht: Bei Berührung der oberen linken Ecke des 
Touchfeldes außerhalb der aktiven Displayfläche springt die Anzeige zur 
Startseite zurück. Die Startseite ist die 1. Seite eines Projekts. Der Editor 
zeigt sie nach dem Öffnen eines Projekts unmittelbar an.
Ein Jumper kennt zwei Zustände: nicht gedrückt und gedrückt. Er wird beim 
drücken auf seine Schaltfläche selektiert (gedrückt). Erst beim Loslassen 
über der Schaltfläche löst er den Sprung zu einer anderen Seite aus.

Button
Ein Button kennt zwei Zustände: nicht gedrückt und gedrückt. Bei Berührung 
wird jeweils ein Telegramm ausgelöst. Der Button unterscheidet hierbei die 
Betätigungsdauer (kurz, lang, dauerhaft). Er unterstützt wahlweise einer der 
folgenden Funktionen:

• toggle (obj 0 umschalten)



• on (obj 0 immer einschalten)
• off (obj 0 immer ausschalten)
• brighter (obj 0 heller dimmen)
• darker (obj 0 dunkler dimmen)
• on / brighter (kurz: obj 0 einschalten, lang: obj 1heller dimmen)
• off / darker (kurz: obj 0 ausschalten, lang: obj 1 dunkler dimmen)
• up (obj 0 aufwärts bewegen)
• down (obj 0 abwärts bewegen)
• step up (obj 0 schrittweise aufwärts bewegen)
• step down (obj 0 schrittweise abwärts bewegen)
• up / step up (kurz: obj 1 schrittweise auf, lang: obj 0 aufwärts)
• down / step down (kurz: obj 1 schrittweise ab, lang: obj 0 abwärts)

Um die Vielfalt an Icons zu reduzieren kann ein Button individuell beschriftet 
werden, auch wenn er standard- Icons benutzt. Hierzu wird ein Text („label“) 
über die gewählten Icons geblendet. Bei betätigtem Button lässt sich der Text 
leicht verschieben, um einen perfekten 3D Eindruck zu liefern.



• label
Dieser Text wird über die gewählten Icons geblendet. Wenn dieses Feld 
leer ist, dann bleiben die Icons unverändert erhalten.

• color
Der Text wird in dieser Farbe angezeigt.

• obj 0, obj 1, function
Gruppenadressen der Kommunikationsobjekte 0 und 1 sowie Funktion 
des Button. Siehe Auflistung oben.

• btn up / btn down
Icons zur Darstellung des Button im nicht gedrücktennn (btn up) und 
gedrückten (btn down) Zustand. Die Icons müssen vorab in die 
Iconbibliothek geladen worden sein und werden aus dieser hier 
ausgewählt. Beim neuerlichen erzeugen eines Button wird das aktuell in 
der Iconbibliothek ausgewählteee Icon als „btn up“ und das 
Nachfolgende als „btn down“ verwendet.

LED
Eine LED ist ein binäres Anzeigeelement und kennt zwei Zustände: Ein- und 
ausgeschaltet. Hierzu stellt das LED Element zwei unterschiedliche Icons 
abhängig vom Zustand des zugeordneten Binärobjekts dar. 
Um die Vielfalt an Icons zu reduzieren kann eine LED individuell beschriftet 
werden, auch wenn sie standard Icons benutzt. Hierzu wird ein Text („text on“ 
bzw. „text off“) über die gewählten Icons geblendet. Bei eingeschalteter LED 
lässt sich der Text leicht verschieben, um einen perfekten 3D Eindruck zu 
liefern.
Bei Berührung sendet das LED Element optional einen Schaltbefehl mit 
invertiertem Objektzustand auf den Bus (Umschaltfunktion).



• text on
Dieser Text wird bei binärem Objektzustand „1“ über das Icon „led on“ 
geblendet.

• text off
Dieser Text wird bei binärem Objektzustand „0“ über das Icon „led off“ 
geblendet.

• color
Die Texte werden in dieser Farbe angezeigt.

• listen
Gruppenadresse für das Empfangsobjekt, dessen Zustand dargestellt 
wird.

• send
Gruppenadresse für das Sendeobjekt, über das ein Umschalten 
ausgelöst werden kann. Hierzu wird bei berühren des LED Elements 
ein binäres Schalttelegramm mit invertiertem Zustand des „listen“ 
Objekts gesendet.
Wenn die Sendeadresse leer ist sendet das LED Element keine 
Umschalttelegramme und hat reine Anzeigefunktion.

• Led off
Icon aus der Iconbibliothek das im Zustand „aus“ angezeigt wird.

• Led on
Icon aus der Iconbibliothek das im Zustand „ein“ angezeigt wird.



S-Button
Der „S-Button“ stellt eine Kombination aus „Button“ und „LED“ dar. Er kennt 
vier Zustände: 

• aus und nicht gedrückt
• aus und gedrückt
• ein und nicht gedrückt
• ein und gedrückt

Der Zustand ein oder aus des S-Button Elements wird durch sein 
Empfangsobjekt („listen“) bestimmt.
Der S-Button sendet bei Betätigung ein binäres Schalttelegramm an die 
Gruppenadresse des Sendeobjekts („send“), das seinem invertierten Zustand 
entspricht (Umschalter).

• color
Der Text wird in dieser Farbe angezeigt.

• send
Gruppenadresse für das Sendeobjekt. Empfang erfolgt stets über 
Objekt „listen“.

• listen
Gruppenadresse für das Empfangsobjekt.

• Btn up off, btn down off



Icons für den Button im Zustand „Aus“. Das Icon „Btn up off“ wird im 
nicht betätigten, das Icon „Btn down off“ im gedrückten Fall angezeigt.
Der Text „label“ wird diesen Icons überlagert. Bei „Btn off down“ wird 
der er um text dx/text dy verschoben überlagert.

• Btn up on, btn down on
Icons für den Button im Zustand „Ein“. Das Icon „Btn up on“ wird im 
nicht betätigten, das Icon „Btn down on“ im gedrückten Fall angezeigt. 
Der Text „label“ wird diesen Icons überlagert. Bei „Btn on down“ wird 
der er um text dx/text dy verschoben überlagert.

Value
Das Value Element stellt Analogwerte, die es über den Bus empfängt, als 
Zahlenwert dar. Die Analogwerte können in folgenden Formaten übermittelt 
werden:

• 1 Byte absolut, 0-100%
• 1 Byte absolut, 0-255
• 2 Byte Fließkomma
• 4 Byte Fließkomma

Die Umrechnung des Objektwertes zur Darstellung erfolgt automatisch 
anhand des ausgewählten Objekttyps. Die Anzahl der Vor- und 
Nachkommastellen kann eingestellt werden. Sollten die gewählten 
Vorkommastellen nicht ausreichen wird ihre Anzahl automatisch vergrößert 
und die Zahl entsprechend länger.
Der Hintergrund des Anzeigebereichs muss gleichmäßig gefärbt sein. Ein 
strukturierter Hintergrund wird unter Umständen nicht korrekt dargestellt. Dies 
muss bei Value Elementen mit transparentem Hintergrund beachtet werden.



• value
Objekttyp des Kommunikationsobjekts.

• integers
Anzahl der Vorkommastellen, die mindestens angezeigt werden.

• decimals
Anzahl der Nachkommastellen, die angezeigt werden.

• unit
Einheit der Messgröße, wird bei der Ausgabe an den Zahlenwert 
angehängt. Eingabe eines beliebigen Textes ist hier möglich.

• listen
Adresse des Kommunikationsobjekts zum Empfang des Zahnwertes.

• text color
Farbe in der Zahlenwert und Einheit dargestellt werden.

• background
Bestimmt die Hintergrundfarbe des Value Elements. Nur aktiv, wenn der 
Parameter „opac“ gesetzt ist.

Picture
Das Bildelement Picture stellt ein statisches Hintergrundbild dar. Das Bild 
kann maximal die komplette Displayfläche (320x240 Pixel) einnehmen. Es 
können beliebig viele Hintergrundbilder auf einer Grafikseite platziert werden. 
Damit lassen sich Seitenhintergründe völlig frei gestalten.



Hinweis: Wenn die gesamte Seite mit Elementen bedeckt ist, kann die 
Hintergrundfarbe der Seiten auf „Transparent“ geändert werden. Das spart 
Zeit beim Bildaufbau. Die Hintergrundfarbe kann durch Doppelklick auf eine 
leere Stelle der Seite eingestellt werden.
Ein Picture Element unterstützt folgende Parameter:


